
 
 

 
SUBJECT: DATA PROCESSING​​ ​ ​ ​ ​ CLASS: SS1 

 
SCHEME OF WORK 

 
WEEK​ TOPIC​ ​  

1.​ REVISION. 
2.​ WORD PROCESSING I. 
3.​ WORD PROCESSINGII. 
4.​ WORD PROCESSING III. 
5.​ SPREADSHEET I. 
6.​ SPREADSHEET II. 
7.​ SPREADSHEET III. 
8.​ DATABASE MANAGEMENT I. 
9.​ DATABASE MANAGEMENT II. 
10.​ DATABASE MANAGEMENT III. 
11.​ REVISION. 
12.​ EXAMINATION. 

 
REFERENCES 

●​ Data Processing for Senior Secondary Schools by Hiit Plc. 
●​ Modern Computer Studies by Victoria. 
●​ Computing Essentials by West patterns Technologies Limited.  

 
 
WEEK ONE 
TOPIC: WORD PROCESSING I 
Word processing is the phrase used to describe using a computer to create, edit and print documents. It is 
also the creation, input, editing and production of a document with a computerized device. A word 
processing package enables you to type in and manipulate text.  It helps you to enter, store, format, copy 
and print text.  It is software that turns the computer into a sophisticated typewriter. The word processing 
software allows you to determine how you want the finished page to look i.e. page size, line, width, margin 
etc.  Once you are satisfied that everything looks all right, you can print out any number of copies on paper. 
 
BASIC FEATURES 
The basic functions are  

●​ Text editing  
●​ Word wrap  
●​ Creating documents. 
●​ Text can be typed, inserted, deleted.  
●​ Text can also be centered between left and right margins. 
●​ Headers and footers 
●​ Page numbering. 

 
Functions include layout setting, copy, move, search and replace text can be copied or moved within the 
document and any occurrence of text can be replaced with another block of text. 
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​ ​ ​ ​ ​ MICROSOFT WORD 
 
EVALUATION 

1.​ What is word processing? 
2.​ What is the difference between a text editor and a notepad? 

 
USES OF WORD PROCESSING 

1.​ It allows saving of works for future purposes. 
2.​ Word processing packages come with many handy features such as borders, text layout etc. 
3.​ It allows plenty of professional quality document templates. 
4.​ Easy to detect and correct mistakes. 
5.​ It allows correction of spellings and grammar. 
6.​ Inserting elements from other software such as illustrations and photographs. 

 
GENERAL EVALUATION 

1.​ What do you understand by text editing? 
2.​ Explain header and footer. 
3.​ State uses of word processing. 
4.​ Mention three basic functions of word processing. 

 
READING ASSIGNMENT 
Computing Essentials by West patterns Technologies Limited, P. 24 
 
WEEKEND ASSIGNMENT 

1.​ A phrase that is used to describe using a computer to create, edit and print documents is known as 
__ A. word processor B. word processing C. ms-word D. corel processing 

2.​ ___ enables you to manipulate texts. A. Processing B. word processor C. Ms-Corel  
D. Corel 

3.​ Word processing packages come with these features except……A. borders B. margins  
C. templates D. images 
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4.​ All of these is an advantage of Word processing except……  A. easy to detect errors. B. it allows 

professional works. C. documents are not safe. D. none 
5.​  Features of word processing include all except………..A. copy B. page Numbering C. imaging Text 

D. margin alignment. 
 

THEORY 
1.​ What is the difference between a text editor and a notepad? 
2.​ List THREE basic functions of a word processing. 

 
 

WEEK TWO 
TOPIC: WORD PROCESSING II 
Examples of Word Processor:  
A word processor is a computer software application that performs the task of creation and printing of 
electronic documents. There are several types of word processors; they include Word Perfect, Word Star, 
MS-Word, Loco Script, Ami-Pro, Word Craft, and WordPad etc. 

1.​ Microsoft Word: it is part of the Microsoft office suite. Word consistently wins the title of the most 
widely word processing program worldwide. Besides basic word processing functions. Word also has 
desktop publishing capabilities. All the Microsoft office programs have the capacity to work together. 
An excel worksheet can exist within a word document. Word also has the power to easily merge with 
Excel lists or from an access database files. 

2.​ Corel Word Perfect: word perfect suite contains several software programs essential for business 
and home users. The suite comes with WordPerfect word, QuattroPro spreadsheet program, Corel 
presentations and WordPerfect mail. 

3.​ OpenOffice: The OpenOffice suite includes a word processor, spreadsheet, presentation program, 
database and graphics editor. As with Microsoft office, the OpenOffice programs also work with one 
another. 

 
EVALUATION 

1.​ Define word processor. 
2.​ List the types of word processors. 

 
The simplest programs that do word processing are known as text editors. These programs are designed to 
be small, simple and cheap. Almost all operating system made comes with at least one text editor built in. 
most editors are saved files in a special format called ASCII (American Standard Code for Information 
Interchange). Text editors are wonderful programs. The most common text editor is the notepad which 
comes with windows. Others are: 

●​ Edit which comes with Disk Operating System (DOS). 
●​ SimpleText which comes with Macintosh. 

The major difference between a text editor and word processor is that word processors have special 
features that are used to beautify texts. They have varieties of colours and other icons while the text editors 
can only accept text with little features such as changing of font’s colours, sizes, etc. The common type of 
text editor is the notepad that comes with window systems. 
 
GENERAL EVALUATION 

1.​ Why is Microsoft Word preferred over other word processor? 
2.​ Differentiate between a text editor and a word processor. 
3.​ List two types of text editor. 
4.​ What is Microsoft word? 
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READING ASSIGNMENT 
Computing Essentials by Westpatterns Technologies Limited. P. 25 
 
WEEKEND ASSIGNMENT 

1.​ Computer software that performs the task of creation and printing of electronic documents is 
called…….A. word package. B. word Processor C. excel package  
D. corelpage 

2.​ Which of these word processors has the ability to merge Excel lists? A.corel word     B. word perfect 
C. microsoft word D. pagemaker 

3.​ The “Ms” in Ms-Word stands for…………A. miss B. miscellaneous C. macros        D. microsoft. 
4.​ Word processor includes all except………….A. word perfect B. word corel C. word Star D.  Loco 

Script 
5.​ Microsoft Word is preferred to other word processing packages because A. it is cheap B. it is more 

friendly C. it accepts data faster D. none 
 

THEORY 
1.​ State the benefits of Microsoft word over other word processors. 
2.​ Name other programs that come with Corel Suite. 

 
 
WEEK THREE 
TOPIC:WORD PROCESSING III 
CREATING A WORD DOCUMENT 
Click on the start icon to display the start icon to display the start menu and then click on the Microsoft word 
icon. The program gives you an empty one to type. 
 
HOW TO SAVE A DOCUMENT 

●​ Start a new document in word and type your text. 
●​ Click file in the top left hand corner of the screen. 
●​ From the menu, choose save as. 
●​ A ‘Save As’ dialogue box will come up. It will show the folder where you will be saving.  
●​ Type in the name of your document and click save. 

NOTE: You can also save your document using the shortcut “Ctrl S” 
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SAVING FORMATS 
Documents can be saved in different file formats depending on what purpose you intend to use it for. Click 
on the down arrow to the right save in section of the dialog box, which will display a drop down menu, 
choose the file format you want for your document. File formats include HTML, PDF, RTF etc. 
 
OPENING MS WORD DOCUMENT 

●​ On the menu bar, click file and then click open icon.  
●​ Click the folder and the file you want to open. 
●​ Click the file. 
●​ Click open. 

 
GENERAL EVALUATION 

1.​ Highlight steps in loading word document. 
2.​ Explain how to create ms word document. 
3.​ Highlight how to save a new document in ms word. 
4.​ List two types of document format. 

 
READING ASSIGNMENT 
Essential Computing by Western Patterns. P. 21 

 
WEEKEND ASSIGNMENT 

1.​ File option is always in the……… hand corner of the screen. A. left hand B. right hand C. middle 
hand D. none 

2.​ A ‘save’ dialogue box will come up when you click ___ A. edit B. save C. Open D. A and B 
3.​ All except one are examples of text editor. A. Edit B. SimpleText C. Both A and B D. None 
4.​ Word processor includes all except ___ A. word perfect B. word corel C. word star  

D. loco script 
5.​ The last step when saving a document is ---- A. click open B. click on save C. rename your folder D. 

C and B 
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THEORY 

1.​ Highlight how to create a word document. 
2.​ How do you save your document in a different format? 

 
 
WEEK FOUR 
TOPIC:SPREADSHEET I 
DEFINITION OF SPREADSHEET: A spreadsheet is a collection of cells organized into rows and columns 
where data is stored and manipulated. The spreadsheet is known as worksheet. A spreadsheet begins with 
row number one and column A. A cell is a space in a worksheet formed by the intersection of a row and a 
column. Each cell can contain a number, text or formula. A cell can also reference another cell in the same 
worksheet, the same workbook or a different workbook. Each cell has an address called Cell 
Referencee.g. A1, B3, C7 etc. combination of more than one sheet is referred to as workbook. The 
worksheets can accept thousands of rows of data and columns in form of fields.Active Cell is recognized 
by heavy border surrounding. It is the cell that is currently worked upon. 
 

 
​ ​ ​ ​ A SPREADSHEET 
 
CONTENT OF SPREADSHEET 
When you are setting out a spreadsheet, you have to enter values, labels and formulas. 

●​ VALUES: Values are those numbers you already know before starting the spreadsheet operation. 
These values are inserted into cells of the spreadsheet. 

●​ LABELS: Labels are words you enter to explain the values. You would not just enter a list of numbers 
without explanation. Putting labels next to each of the numbers makes it easier for to check it 
through. 

●​ FORMULA: Formulas are the mathematical equations you insert into the cells. Formulas are 
commands that instruct the computer on what to do. 

 
EVALUATION 

1.​ Define a worksheet. 
2.​ What do you understand by cell reference? 

​ ​ ​ ​  
 
 
USES OF SPREADSHEET 
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There are various uses of spreadsheet. It uses varies according to the intended purpose. Some of its uses 
are as follows: 

1.​ Spreadsheets are used for administrative functions.  
2.​ Spreadsheets are used for creating reports. 
3.​ They are used for preparation of daily sales. 
4.​ They are used in computing school results. 
5.​ They are used for project budgeting control. 
6.​ They are used for drawing balance sheets. 
7.​ Excel can store and calculate the data as directed using existing data. 
8.​ Spreadsheet can be used for analysis and decision making. 
9.​ It makes calculations much easier than working things out yourself. 

 
GENERAL EVALUATION 

1.​ State the uses of spreadsheet. 
2.​ Excel can be used to create analysis, Explain. 
3.​ What is an active cell? 
4.​ What are the contents in spreadsheet? 

 
READING ASSIGNMENT: Modern Computer studies by Victoria, page 25 
WEEKEND ASSIGNMENT 

1.​ A cell can also reference another cell in the same……..A. worksheet B. workbook  
C. cellular D. sheet 

2.​ Spreadsheet can be used for data analysis and…………making A. cell B. decision  
C. data D. reference 

3.​ The………….. can contain thousands of rows of data and columns in form of fields. A. cell B. 
worksheet C. reference cell D. excel 

4.​ The cell that is been currently worked upon is known as ……………cell. A. current B. active C. 
reference D. initial 

5.​ A ……….. can also reference another cell in the same worksheet. A. cell B. sheet  
C. worksheet D. none 

 
THEORY 

1.​ Define an active cell. 
2.​ List and explain the THREE major contents in a spreadsheet. 

 
 
WEEK FIVE 
TOPIC:SPREADSHEET II 
EXAMPLES OF SPREADSHEET 
There are various types of spreadsheet software which include: 

●​ Microsoft excel 
●​ Lotus 1-2-3,  
●​ Starview, 
●​ Supercal etc. 

 
MICROSOFT-EXCEL 
Out of the many examples of spreadsheet packages, Microsoft excel is the most commonly used because 
of its friendly features. Microsoft excel is part of Microsoft suite. The suite comes in various version such as 
2000, 2005, 2007,2010, 2015 etc. 
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Ms- Excel is primarily used for analysis and calculation due to its flexibility. It has a lot of calculating 
features and mathematical formulas. Various kinds of mathematical calculations can be done using MS 
excel. Microsoft Excel is a spreadsheet package used mainly for mathematical calculations and numerical 
analysis. Examples of calculations that can be performed using MS Excel include; addition, subtraction, 
multiplication, division, average, etc. 
 
Formulas are often used to carry out calculations in Ms excel. The desired formula for any calculation must 
be preceded with an equal sign (=). 
 
STARTING MS EXCEL 
Starting Worksheet (Using Microsoft Excel) 
Click Start button; 
Click All Programs; 
Click Microsoft Office; 
Click Microsoft Office Excel. 
 
EVALUATION 

1.​ Highlight the steps for starting Ms-Excel. 
2.​ What are the types of calculations that can be performed in Ms-Excel? 

 
ARITHMETIC OPERATORS USED IN MS EXCEL 
+  Addition​ ​ ​ -  Subtraction 
/   Division ​ ​ ​ * Multiplication​ ​ ^  Exponential 
When creating a formula, you must know MS Excel’s order of operations. Certain operations are 
performed before others. The term PEMDAS is the acronym to denote MS Excel’s order of operation. 
P ------​Parenthesis (Bracket) 
E -----​Exponential 
M -----​Multiplication 
D -----​Division 
A -----​Addition 
S ------​Subtraction​  
Calculations enclosed in parenthesis are performed first, followed by calculations involving exponentials. 
Multiplication and division operations are performed next because they are considered equal in importance. 
They are performed in the order in which they are encountered from left to right. Addition and subtraction 
are performed last in the order in which they are encountered from left to right. 
 
Formulas in MS Excel 
Examples: 
Addition​ =C3+D3​ ​ ​  
Subtraction​ =C3-D3 
Division​ =C3/D3  ​ ​ ​  
Multiplication​=C3*D3 
Average​ =AVERAGE(C4...C9) 
 
GENERAL EVALUATION 

1.​ In the right order, list the order of calculation operations in Excel. 
2.​ Apart from MS-Excel, list two other types of Spreadsheet packages. 
3.​ Write the full meaning of the acronyms PEMDAS. 
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4.​ List two formulas in Ms-Excel. 

 
READING ASSIGNMENT 
Modern Computer studies by Victoria. Page 52. 
 
WEEKEND ASSIGNMENT 

1.​ The acronym that is used to denote MS Excel’s order of operation is ___ A. PEDDAS B. PEMDAS C. 
PEMMAS D. PEDDMA 

2.​ ___ is the formula for finding average in Ms-excel. A. C2/D2. B. =AVERAGE (C4..C9) C. =C4:C9 D. 
AV (C4..C9) 

3.​ Which of the Calculations are performed first in excel? A. Multiplication B. Addition     C. In 
parenthesis D. Division 

4.​ All these except one are example of spreadsheet packages. A. Lotus 1-2-3.  
B. Supercal C. Corel sheet D. Ms Excel 

5.​ “*” represents ___ A. addition B. exponential C. multiplication D. none 
 
THEORY 

1.​ State the steps to load Excel 
2.​ What does the acronym, PEMDAS stand for? 

 
 
WEEK SIX 
TOPIC:SPREASHEET III 
LOADING EXCEL APPLICATION 
Click on all programs, check the programs and click on the Microsoft suites then click on the excel 
application. 
 
CREATING EXCEL DOCUMENT 
Once Excel is open, you can enter data into a file by clicking on a particular cell, then typing  
text, numbers, or formulas. Your changes will be entered into the current cell. 

●​ Press the tab to enter your data and move the active cell to the right of the current one. 
●​ Press enter key to enter your data and move the active cell to the next row, usually to the beginning 

of that row. 
●​ Use the arrow keys to enter your data and move the active cell in the indicated direction. 
●​ Press the end key, right-arrow key to move to the last cell in a row. 
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ENTERING DATA IN A WORKSHEET 
Locate the cell where you want to enter data on the worksheet and click on the cell. For example point and 
click on cell A1. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Type in your entry from the keyboard and notice the appearance of the entries in the formula bar with the 
cell address. 
Press ‘Enter’ key. 
 
EVALUATION 

1.​ What are the steps involved in creating a Spreadsheet? 
2.​ Explain how to enter data into Excel. 

 
EDITING DATA IN A WORKSHEET 
Wrong entries may either be entirely re-typed or the particular cell/range of cells can be corrected.  
 
To retype: 
Move the cell pointer to the cell to be corrected or re-type the entry and press ‘Enter’ 
To correct only the mistake: 
Move the cell pointer to the cell and double click on the cell. 
Make the correction by inserting, deleting or retyping. 
Press ‘Enter’. 
 
SAVING A WORKSHEET 
Saving for the first time: 
Click on ‘Home’ button, 
Click ‘Save As’ button and wait for a dialog box to open. 
Type in your desire filename (i.e. the name of the document). 
Click ‘Save’ button or press enter on the keyboard. 
Saving while working (after the first saving). 
Click on ‘save’ icon on the Quick Access tool bar or click on ‘office button’ to open the menu.and click ‘save’ 
from the options. 
 
RETRIEVING A SAVED WORKSHEET 
Retrieving a worksheet means to open an already saved worksheet from its location in the computer. This 
is usually done to view, edit or update the worksheet. 
Load/start Microsoft Excel 
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Click on ‘Office Button’  
Click ‘Open’ option from the list and wait for a dialog box to open. 
Navigate to the file you want to open and double click on it.  
 
GENERAL EVALUATION 

1.​ Define a cell. 
2.​ State steps involved in saving a worksheet for the first time. 
3.​ Highlight the steps in retrieving a saved document. 

 
READING ASSIGNMENT 
A Handbook on Computer Studies for Schools and Colleges by NiyiAdekolegan 
 
WEEKEND ASSIGNMENT 

1.​ ___ is a collection of cells organized into rows and columns where data is stored and manipulated.  
A. Worksheet B. Graph C. Workbook D. Active cell 

2.​ ___ is a space in a worksheet formed by the intersection of a row and a column. 
A. Workbook B. Sheet C. Cell D. Cell Reference. 

3.​ There are ……… rows per worksheet in Excel. A. 1,048,576 B. 1,048,765  
C. 1,408,576 D. 1,022,333 

4.​ There are ___ columns per worksheet in Excel. A. 16,387 B. 16,384 C. 16,684 
D. 15,341 

5.​ The address of a cell is known as ___ A. Cell space B. Cell reference C. Cell Menu 
D. Active cell 

 
THEORY 

1.​ Highlight the steps in saving a worksheet 
2.​ In Excel, what do you understand by the term “retrieving”? 

 
 
WEEKSEVEN 
TOPIC:DATABASE MANAGEMENT I 
Database is an application that is used to store information in a structured way. It is a collection of records 
or data in an organized form. 
 
A database management system is a collection of computer software that enables users to define, create 
and maintain a database. A database management system (DBMS) is a computer application that interacts 
with the user, other applications and the database itself to capture and analyse data. The general purpose 
of database management system (DBMS) is designed to allow the definition, creation, querying and 
administration of database. The DBMS serves as an interface between the database and end users or 
application programs, ensuring that data is consistently organized and remain easily accessible. Database 
Administrators are those that control the database system. They also control the access and security 
aspects of the database. 
 
FUNCTIONS OF DBMS 
A DBMS makes it possible for users to create, edit and update data in database files. The functions also 
include 

●​ Concurrent access to the same database at the same time. 
●​ It creates security rules to determine access right of users. 
●​ It improves the integrity of the data in the database. 
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●​ It also provides data dictionary for description of data. 

 
 EVALUATION 

1.​ What do you understand by database management? 
2.​ Who is a database administrator? 

 
EXAMPLES OF DATABASE MANAGEMENT PACKAGES 
There are varieties of database management system. Some of these are: 

1.​ Microsoft Access: it is a DBMS developed by Microsoft. It stores data in its own format based on 
the access jet engine. It has the facilities like importing or linking directly to data stored in other 
databases. 

2.​ MySQL: it is an open source DBMS. One of the most popular DBMS.  
3.​ Oracle: it is an object relational database management system. 
4.​ Microsoft SQL server: it was developed by Microsoft. The primary function of this software is to 

store and retrieve the data as requested by other applications, whether those applications are on the 
computer or running on other computer across the network. 

5.​ Filemaker: it was begun as a MS–DOS based computer program. It is a cross platform relational 
database management system. 

 
DATABASE TERMINOLOGIES: 

●​ Rows: are the records. 
●​ Column: is vertical and labeled alphabetically. 
●​ Field: is a group of related characters in a file 
●​ Character: is a single symbol in a file. 
●​ Record: is made of a number of fields that are related together and treated as an entity. 

 
GENERAL EVALUATION 

1.​ List other types of database applications apart fromMs-Acess. 
2.​ List three database terminologies and explain them. 
3.​ What is a record in database? 
4.​ Mention two database packages and briefly on them. 

 
READING ASSIGNMENT 
Data Processing for Senior Secondary Education by HiiT Plc. 
 
WEEKEND ASSIGNMENT 

1.​ The person that controls the entire database system is called ___ A. database manager. B. database 
analyst C. computer Analyst D. database administrator. 

2.​ A collection of computer software that enables users to define, create and maintain a database is 
refers to as ___ A. database program B. database management  
C. computer software D. database pro 

3.​ One of these DBMS began with MS- Dos. A. MS-Access B. MySQL C. Corel  
D. Filemaker 

4.​ The general purpose database management system (DBMS) is designed to allow all except one.  A. 
definition B. creation, C. querying D. multiplying 

5.​ Concurrent in database management means….A. to access by many people at once  
B. One person at a time C. both A and B D. none 
 

 
Downloaded from eduresource.com.ng  ©Educational Resource Concept  
 



 
THEORY 

1.​ List and explain three examples of DBMS. 
2.​ List three functions of DBMS. 
3.​ Compare Row and Record. 

 
 
WEEK EIGHT 
TOPIC:DATABASE MANAGEMENT II 
CONTENT 
Database packages are used to design a database in a computer. Example of a common database 
package is Microsoft Access. MS Access is a Relational Database Management System used to create and 
modify databases.  
 
USING MS- ACCESS FOR DATABASE 
To create a database on the computer with MS Access 
Load MS Access: do the following; 

●​ Click on the Start Menu 
●​ Point to All program 
●​ Point to Microsoft Office 
●​ Click on Microsoft office Access 

 

 
 

 
Creating Database 
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●​ From the displayed window, click on blank database. 
●​ By the right hand side of the windows, where the arrow is pointing in the picture-screen above, click 

inside the file name text box and type the desired database name. 
●​ Click on Create command button. A database with the filename given will be created 

Files are created as tables in the database 
 
Creating a file 

●​ Click on Create menu and select Table 
●​ At all Tables tab, right click on any of the table. 
●​ Select design View 

 

 
In the Save As dialog box, type a desired table name (e.g. Student Table) in the Table Name text box and 
click ok. 
Tables in database on a computer are composed of rows and columns. A table in MS Access is organized 
into rows and columns like the picture screen shown below. 

 
A row contains records or diverse fields. The rows specify the number of records in the table. For example, 
in the picture-screen above, there are six records in the student table. 
A column usually represents a field in a database table. It contains specify the type of information. For 
example, in the picture screen above, there are three fields (data fields), REG. No., Surname, and first 
name. 
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EVALUATION 

1.​ List the steps on how to lad MS-Access. 
2.​ How do you create database using Ms- Accsess 

 
Create Fields with Data Types  
Fields are assigned field names relevant to the information they keep. Field names are assigned data types 
which determine the kind of data they accept as input. For example in MS Access table above, Surname 
are alphabetic, the fields will not accept numeric (numbers) inputs 10 or 500 as surname. To set data type 
for field in MS Access, follow the steps below;  

●​ After creating the table in design view under the field name tab, then type the field name and under 
the data type tab next to the field name, click the drop down menu and select AutoNumber as shown 
below. 

 
For example, using the above picture screen, the field name ID Number will be assigned Number data type 
since the ID Numbers will be numeric. In the same way, TEXT data type will be assigned to Surname and 
First name. 
 
Unique Identifier 
A table contains a unique identifier i.e. a KEY. In MS Access, a default primary key is usually specified for 
the first field. To set another field of your choice as primary key, right click on the first cell and select Primary 
Key. 
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Note: The symbol of a key should appear beside the field, after setting that field as a unique identifier. If it 
does not appear repeat previous steps. 
 
Creating Database 
Generally, creating database using any DBMS entails the following basic steps: 
Define the Database Structure 
The database structure specifies the type of database organization that should be used. If the relational 
form is selected, the database structure will include RDBMS, structure of table, number of rows, number of 
columns, the key, and relationship of the database etc. 
 
Specify Field Type 
When a database is being created, all fields are set to accept a particular type of input by specifying a field 
type. A field type is also known as a Data type. The essence of a data type is to prevent a wrong input from 
being stored in a database (i.e. database integrity). Usually the name of a data type varies with DBMS but 
portrays a general meaning. These include; 

●​ Alpha numeric/ text field: Fields that accepts both numbers and text e.g. ASP2548. 
●​ Numeric Fields: Fields that accepts numbers in two forms: Real number i.e. decimal numbers e.g. 

8.15, 9.1 and integers’ i.e. whole numbers e.g. 125, 80 etc. 
●​ Date Fields: They store data in date format e.g. 11-04-2009 
●​ Boolean fields: The data accepted by these fields are either Yes/No or True/False. 
●​ Memo: Long text. Use for long pieces of text. Such as notes and long description. Can store up to 

64,000 characters. 
●​ Currency:  Use for currency. 
●​ AutoNumber: Unique sequential numbers or random number automatically inserted when you create 

a record. Use to create primary key. 
●​ Hyperlink: Use to store hyperlink 
●​ Attachment: use to store attachments e.g files, images etc. 
●​ OLE Object: Use to attach an OLE object such as word document, Spreadsheet,  or  PowerPoint 

Presentation 
 

Downloaded from eduresource.com.ng  ©Educational Resource Concept  
 



 
GENERAL EVALUATION 

1.​ Define the Database Structure. 
2.​ What is unique identifier? 
3.​ What is Hyperlink? 

 
READING ASSIGNMENT 
Data Processing for Senior Secondary Education by HiiT Plc. Chapter Two, pages 58 - 63 
 
WEEKEND ASSIGNMENT 

1.​ Another name for field type is known as ___ A. file type B. name typeC.record type D. data type 
2.​ Another name for unique identifier is known as ___ A. key B. dataC. field D. record 
3.​ ___ is an attribute or field that can be used to identify a record in a database table or file. A. data B. 

field C. key D. table 
4.​ ___ is used to design a database in a computer. A. Database package B. Graphics package C.  

Spreadsheet package D. Word Processing package 
5.​ The data accepted by these fields are either Yes/No or True/False is ___ A. primary key B. Boolean 

fields C. Data D. None 
 
THEORY 

1.​ Define database Model. 
2.​ List and explain types of database Model. 
3.​ All fields are set to accept a particular type of input, list and explain the data types. 

 
 
WEEK NINE 
TOPIC:DATABASE MANAGEMENT III 
INPUT DATA 
After the field names and their data types have been specified, then records are stored in the database by 
specifying the appropriate input. In MS Access, to input a data:  

●​ Double click on the Student Table at the left hand pane of MS Access windows 
●​ Enter the data beneath the field names and click on the next cell to populate data. 

To keep database updated, data inputted into the database must be saved regularly. Keyboard command 
CTRL + S is used. Alternatively, you click on the Office button and save. 
BASIC OPERATION 
The basic operations to be considered are: 

●​ Searching 
●​ Sorting 
●​ Modifying 
●​ Generate report 

 
Searching 

●​ On the Tools Menu, click Options 
●​ Click the Edit/Find tab 
●​ Under Default find/replace behave, do one of the following: 

●​ Select Fast Search to search the current field and match the whole field. 
●​ Select General search to search all fields and match any part of the field. 
●​ Select Start of Field Search to search the current field and match the beginning characters of 

field. 
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●​ DBMS have certain command for saving a database. For example in MS Access, select the 

save option on the MS Access window to save. 
EVALUATION 
1. Define the basic operations in Database. 
2. How to you enter data in Ms-Access? 
 
Sorting 
To sort records in form view or in datasheet view, follow these steps: 

1.​ Start MS Access, and then open the database that you are working with. 
2.​ Open the table or the form whose data you want to view. 
3.​ Click the field that you want to use for sorting records. To sort records in sub-form, click the field that 

you want to sort. To sort records in a sub-datasheet, display the sub-datasheet by clicking expand 
indicator, and then click the field that you want to sort. 

4.​ On the records menu, point to sort, and then click Sort Ascending or Sort Descending. NOTE: In a 
form, you can only sort on only one field at a time.  

Sorting with sub-datasheet 
In datasheet view, when you sort the sub-datasheet for one record, MS Access sorts all the sub-datasheets 
at that level. In a datasheet or sub-datasheet, you can select two or more adjacent columns at the same 
time, and then sort them. Access sorts records starting with the leftmost selected column. When you save 
the form or datasheet, Access saves the sort order. 
Sorting Records on a Report 

1.​ Start MS Access, and then open the database that you are working with. 
2.​ Open the report in Design View. 
3.​ ON the View menu, click sorting and Grouping to display the sorting and Grouping dialog box. 
4.​ In the first row of the Field/Expression column, select a field name or type an expression. NOTE: 

When you fill in the Field/Expression column, MS Access sets the sort order to Ascending. 
5.​ You can sort up to10 fields or expression in a report. To sort your report on more than one field, add 

another field or expression to the Field/Expression column. The field or expression in the first row is 
the first sorting level. The second row is the second sorting level, and so on. 

Modifying Data 
How to Add or edit Data in a Datasheet (Table or Query) or in a Form 

1.​ Open a table or a query in datasheet View or a form in Form View. 
2.​ Do one of the following: 

●​ In MS Office Access 2003 or in earlier versions of Access, to add a new record, point to Go to 
on the Edit menu, and then click New Record.  Type the data, and then press TAB to go to the 
next field. At the end of the record, press TAB to go to the next record. 

●​ In MS Office Access 2007, to add a new record, click the Home tab, and then click New in the 
Records group. 

●​ To edit data within a field, click in the field that you want to edit, and then type the data. 
●​ To replace the entire value, move the mouse pointer to the leftmost part of the field until the 

pointer changes into the plus pointer, and then click. Type the data. 
NOTE: To correct a typing mistake, press BACKSPACE. To cancel your changes both in current field and in 
the entire record, press ESC. 
 
GENERAL EVALUATION 

1.​ State the operations that can be performed in a database. 
2.​ List five (5) data type. 
3.​ List the steps in modifying data. 
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READING ASSIGNMENT 
Data Processing for Senior Secondary Education by HiiT Plc. Chapter Two, pages 58 - 63 
WEEKEND ASSIGNMENT 

1.​ All these are basic operations except ___ A. modifying B. creating C. sorting 
D. Searching 

2.​ One of these explains sorting. A. arrangement of record alphabetically. B. data arrangement in 
ascending or descending order. C. data Movement D. Record Movement from one place to another. 

3.​ In MS Office Access 2007, to add a new record you do ___ A. click the Home tab 
B. open programs C. A and B D. none 

4.​ The data accepted by these fields are either Yes/No or True/False is ___ A. primary key B. Boolean 
fields C. Data D. None 

5.​ Another name for unique identifier is known as ___ A. Key B. Data C. Field  
D.  Record. 

 
THEORY 

1.​ Highlight how to sort data in Ms-Access. 
2.​ List the four basic operations in Database. 
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